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Buffalo River Region

230 E. James Campbell Blvd, #108

Columbia, TN 38401
Marion Bryant, Director
(931) 388-9282

(855) 692-8186 (Toll Free)
FAX: (931) 388-1762
Marion.bryant@tn.gov
Counties Served:

Giles

Hickman
Lawrence

Lewis

Lincoln

Marshall

Maury

Perry

Wayne
Williamson
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Clinch River Region
130 North Main Street, Suite 2
Clinton, TN 37716-3633
Matthew Jordan, Director
(855) 692-8186 (Toll Free)
FAX: (865) 457-8546
matthew.jordan@1tn.gov
Counties Served:
Anderson

Campbell

Claiborne

Grainger

Jefferson

Morgan

Scott

Sevier

Union

Falling Water River Region
208 Minnear Street
Cookeville, TN 38501-3949
Faith Holdredge, Director
(931) 526-4016
(855)692-8186 (Toll Free)
FAX: (931) 528-3311
Faith.holdredge@tn.gov
Counties Served:

Bledsoe

Clay

Cumberland
DeKalb

Fentress

Jackson

Macon

Overton

Pickett

Putnam

Sequatchie

Smith

Van Buren

White

Hatchie River Region
63 Executive Drive
Jackson, TN 38305-2901
Carla Jacobs, Director
(731) 668-0710

(855) 692-8186 (Toll Free)
FAX: (731) 668-6663
Carla.jacobs@tn.gov
Counties Served:
Chester

Decatur

Fayette
Hardeman

Hardin

Haywood
Henderson
Lauderdale
Madison

McNairy

Tipton

Holston River Region
2700 South Roan Street
Suite 435

Johnson City, TN 37601-7587
Nancy Roark, Director
(423) 926-2951

(855) 692-8186 (Toll Free)
FAX: (423) 926-2956
nancy.roark@in.gov
Counties Served:

Carter

Cocke

Greene

Hancock

Hawkins

Hamblen

Johnson

Sullivan

Unicoi

Washington

Obion River Region
542 N. Lindell

Martin, TN 38237

Mary Carpenter, Director
(731) 587-2347

(855) 692-8186 (Toll Free)
FAX: (731) 587-0027
Mary.carpenter @ tn.gov
Counties Served:

Benton

Carroll

Crockett

Dyer

Gibson

Henry

Lake

Obion

Weakley

Ocoee River Region
718 George Street, N.W.
Athens, TN 37303-2214
Beth A. Mercer, Director
(423) 745-5194

(855) 692-8186 (Toll Free)
FAX: (423) 745-8086

Beth.mercer@tn.gov

Counties Served:
Blount
Bradley
Loudoun
McMinn
Meigs
Monroe
Polk

Rhea
Roane

Red River Region

1753 Alpine Drive Suite A
Clarksville, TN 37041
Cecilie Maynor, Director
(931) 645-9531

(855) 692-8186 (Toll Free)
FAX: (931) 645-6695
Cecilie.maynor@tn.gov
Counties Served:
Cheatham

Dickson

Houston
Humphreys
Montgomery
Robertson

Stewart

Sumner

Stones River Region
2118 East Main Street
Murfreesboro, TN 37130-4009
Betty Jo Jarvis, Director
(615) 893-3380
(855)692-8186 (Toll Free)
FAX: (615) 895-6727
Bettyjo.jarvis@tn.gov
Counties Served:
Bedford

Cannon

Coffee

Franklin

Grundy

Marion

Moore

Rutherford
Trousdale

Warren

Wilson

Tennessee Regional Library System, Tennessee State Library & Archives,
Office of the Secretary of State,
Established 1939, Reorganized July 1, 2012




Tennessee Library 100 MB Connectivity

Survey 2016-2017

Collected
Aug. 2016

All 212 Public Libraries served by Tennessee's 9 Regional Library Systems participated
in an Internet Service Speed poll. Current providers as well as alternate providers
were investigated to provide a comprehensive bandwidth footprint for each Public
Library location.

Any bandwidth verification performed through speedtest.net by Ookla, speakeasy.net by MegaPath, speedtest.charter.com by Charter
and speedtest.frontier.com by Frontier

Libraries
Region 212 Total with

Libraries 100MB

Available
Obion River 20 15
Hatchie River 19 14
Red River 14 13
Buffalo River 28 15
Falling Water 20 9
Stones River 25 17
Clinch River 33 24
Ocoee River 27 21
Holston River 26 23
Total 212 151

Libraries lera-lr.les

) with receiving

Region 10omp  Available

Available ~ 100MB

2016

Obion River 15 6
Hatchie River 14 7
Red River 13 0
Buffalo River 14 1
Falling Water 9 1
Stones River 17 5
Clinch River 25 6
Ocoee River 21 6
Holston River 23 3
Total 151 35

Libraries

receiving

Available
100MB
Jul-17
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100 MB Availability for
Tennessee Libraries

100 MB Saturation by Region

W Total Libraries
m 2016
2017

*Only sites with availability included.
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Obion River 5 5 il 0 0 0 3 1
Hatchie River 5 3 0 2 0 2 5 0
Red River 1 10 0 0 0 0 1 1
Buffalo River 14 1 S 4 1 0 1 0
Falling Water 11 8 0 0 0 0 0 0
Stones River 2 2 1 1 0 5 2
Clinch River 8 9 8 1 0 0 1 0
Ocoee River 6 11 0 0 0 0 6 0
Holston River 3 17 0 0 0 0 4 0
Total 61 66 16 8 2 2 26 4

Hurdles to 100 MB Connectivity for
Tennessee Libraries

® Not Available
u Cost

W Free

m Shared

® LAN

m Contract

™ Req. Submitted

m Local Gov.
@ Not Available 100 MB connectivity is not available from multiple internet Providers.
@ Cost Cost with E-rate exceeds library budget.
© Free Current connection is provided at no cost to the library.
@ shared Connection is shared with another entity and library is not the responsible party.
@ AN Connection is a Local Area Network with shared resources to other entities.
© Contract Library is currently under contract for connectivity.
© Req. Submitted A request to increase service has been submitted to board/local government.

© Local Gov. Local Government impedes internet service change.



Tennessee Regional Library System
Hot Spots for Public Borrowing

~ Library Name County Devices Provider
Linebaugh Public | Rutherford | 70 TMobile

_Blount County Blount 45 Tmobile/ Verizon

| Smyrna Public Linebaugh 35 TMobile
Johnson City Public Washington 24 Verizon
Spring Hill Public Maury/Wmson 20 TMobile
Lebanon-Wilson County | Wilson County 20 Verizon
Cleveland-Bradley Bradley | 15 Tmobile
Williamson County Williamson 14 TMobile
Myrtle Glanton Lord Linebaugh 10 TMobile
Sullivan County Sullivan 6 Verizon
Maury County Maury 5 TMobile
Ned R. McWherter | Weakley 5 Verizon
Eagleville Bicentennial Rutherford 5 TMobile
Chester County Chester 4 Verizon

_lohnson County Public Johnson 3 Verizon
Clinton Public Anderson 2 Tmobile
Giles County Giles 1 TMobile
Leiper's Fork Williamson 1 Sprint
TOTAL 285

As of Aug. 15, 2016
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Public Library Standards Survey
Questions Related to Digital Literacy Training

Standards Population “ : 0 :
Satany Sarvad Item Number/Summary Compliant | Compliant
gory 2015 2016
Collections Al Offer tralmlr'\g on the Tennessee 38 43
Electronic Library
Batsannel All Offer traumng for staff members to 64 77
keep tech skills current L
Personnel 50,000 + Have full-time Technology staff 61 65
Services 5,000+ Offered classes in Multi-Media 42 64
Services 5,000+ Offered classes in Social Media 50 74
Services 5,000+ Offered classes in Library Resource 62 89
Services 5,000+ Offered classes in Basic Computer Skills 61 87
Services 5,000+ Offered classes in Office Productivity 54 79
Services 5,000+ Offered classes in Privacy and Security 42 59
Services 5,000+ Offered classes in Internet Searching 61 =87
Provide space and devices for use by
Services 5,000+ community groups for-technology 50 73
training
Services 25,000+ Offer monthly digital literacy classes 55 70
Services 50,000+ Offer twice-monthly digital literacy 65 70
classes
Offer one-on-one technology help
Services 10,000+ sessions up to 10 minutes long, on 74 96
demand
Offer one-on-one technology help
Services 50,000+ sessions up to 30 minutes long, on 95 96

demand
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Standards for Technology

All Levels:

1.

o ®

10.
11.
12,

13.
14.

15.
16.

17.
18.

All library staff demonstrate basic computer literacy, including:

a. The ability to navigate the basic operational and productivity software
necessary to complete core work functions, including word processing and
simple spreadsheets;

The ability to navigate search engines and browsers;

The ability to send and receive email;

An understanding of basic computer terminology; and

A working knowledge of hardware and peripherals (monitors, printers,
keyboards, touchscreens, etc.).

Library has a dedicated Internet connection with adequate bandwidth to support
public demand, at the minimum speeds stipulated in the chart in Appendix VI, as

o e T

Library will have free wireless local area network access to the public. Wireless
Internet access extends to all public areas of the library. v

Each Internet workstation includes protective software and office productivity
software (e.g., word processing, spreadsheets, and presentations), a PDF reader,
and Flash™ Player."

Library has adequate Internet workstations so patrons have access to a computer
with a wait time of 30 minutes or less under normal conditions.

Internet workstations include patron ability to retrieve and store data to portable
devices.vi

Library will have a web presence including one-click access to TEL and
R.E.A.D.S., with information about library programs and activities as well as
library contact information.

Library website content, including links, is reviewed monthly.vit

Library uses an automated circulation system and online public access catalog for
remote patron use.

Library has a designated phone line and responds to calls from the public.
Library policies and procedures ensure privacy and security of patron data. viii

A lockdown software program is installed on public computers, which clears
online session data from public computers. i

Library staff has access to technology support services.

Library has a technology plan that addresses improvement and replacement
schedules. Plan is reviewed and updated annually by the board.

Library has at least one ADA-compliant computer workstation. x

Library staff are empowered to extend public computer sessions, assuring
adequate time for patrons to complete tasks. xi

Library has a public access copier.

Library has a public fax service.

2014 Tennessee Standards for Non-Metropolitan Libraries
Tennessee State Library & Archives
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Level I1I:

1. Library has a dedicated area for technology training.

Library has one or more specialized computer workstations for children.

Library provides accommodation for public use of computers in privacy while
conducting sensitive transactions, within library Internet policies. xiil

Library provides equipment for public to scan documents into digital formats. *iv
At least one public computer workstation is equipped for use by the visually
impaired. ¥

Public computer sessions are timed and managed by session management
software. xvi

7. Library offers color printing,.

w

o Eicp

Levels IV:

1. Website usage statistics are reviewed and analyzed quarterly xvii
2. At least one Internet workstation is equipped with photo-editing software.
3. Wireless printing is available for public use. i

Level V:

1. The library provides computers in private spaces for patrons to take tests and

communicate virtually with others. xix

Video conferencing equipment is available for public use. **

Computers or mobile devices with extended session periods are available within

the library. xx

4. Presentation equipment (e.g. laptop, digital projector, microphone) is available

for public use within the library. *ii

Library maintains spare computers to switch out downed devices with fresh

hardware within a business day. *iii

6. Library uses master image deployment and recovery system for efficient
installation and maintenance of public computers. *iv

7. Online public access catalog and library website are optimized for mobile devices.

v P

o

2014 Tennessee Standards for Non-Metropolitan Libraries
Tennessee State Library & Archives
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Standards for Services
All Levels:

Library participates in statewide interlibrary loan through the statewide courier.
Library provides programming for children on a regularly scheduled basis.
Library enables non-residents to use library materials and technology.

Library provides basic information and referral services.

Library is open a minimum of 20 hours per week, with evening or weekend
hours.

b ZRC o S S

Level II:

1. Library provides quarterly public digital literacy training on one or more of the
following topics:
a. Basic computer skills;
b. Office productivity software (e.g., word processing, spreadsheets,
presentations);
Internet searching;
Privacy and security;
Library resources;
Social media; and
g. Multi-media (e.g. photo, video, audio)*.
2. Library offers space and/or devices to community organizations for technology-
related training.xxvi
3. Library is open 35 hours per week, with evening or weekend hours.

o Ao

Level III:

1. Library provides programming for young adults, adults, and seniors.

2. Library provides full reference services, including standard print and online
reference sources and staff assistance in locating additional materials online.

3. Library is open 45 hours per week, with evening and weekend hours.

4. Library provides one-on-one technology help for patrons on demand for at least
10 minute sessions,xxvii

Levels IV:

1. Library provides programming for all ages.

2. Library is open 55 hours per week, with evening and weekend hours.

3. Library provides monthly public digital literacy training on two or more of the
topics listed in Level I1, item 1.

2014 Tennessee Standards for Non-Metropolitan Libraries
Tennessee State Library & Archives
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Level V:

P

Library is open 60 hours per week, with evening and weekend hours.

Library provides public digital literacy training at least twice per month. Over the
course of a year, training is provided on all of the topics listed in Level II, item 1.
One-on-one training is available for patron-owned devices. *xviil
Library provides one-on-one technology help for patrons by appointment for at
least 30 minute sessions. xxix
Library maintains a collection of technology devices for loan for staff
development and programming purposes. X






Laptop Lap Grant Program

2012-1014
County Laptop Lab Library ;’: 2:;: Z‘; Grant Total T:-Ia(::i:;g '::t:':::;::
Anderson Lake City Public Library 7 $16,076.00 100 141
Benton Benton County Library 12 $21,866.00 339 64
Bledsoe Bledsoe County Public Library 7 $16,076.00 122 198
Campbell Jellico Public Library 12 $21,866.00 60 380
Cannon Cannon County Library System 7 $16,076.00 111 207
Elizabethton Carter County Public
Carter Library 12 $21,866.00 71 250
Barbara Reynolds Carr Memorial
Claiborne Library 7 $16,076.00 94 116
Clay Clay County Public Library 7 $16,076.00 283 121
Cocke Parrottsville Community Library 7 $16,076.00 60 58
Cocke Stokely Memorial Library 7 $16,076.00 60 134
Crockett Crockett County Library 7 $16,076.00 60 42
Cumberland Art Circle Public Library 12 $21,866.00 60 259
Decatur Decatur County Public Library 12 $21,866.00 78 250
Decatur Parsons Public Library $16,076.00 65 203
DeKalb Alexandria Branch Library $16,076.00 107 164
DeKalb Justin Potter Library $16,076.00 113 304
Dyer Mclver's Grant Public Library 7 $16,076.00 88 304
Fentress Fentress County Public Library 12 $21,866.00 103 215
Gibson Mildred G. Fields Memorial Library 12 $21,866.00 140 273
Grainger Bean Station Public Library 7 $16,076.00 60 264
Greeneville-Greene County Public
Greene Library 7 $16,076.00 114 223
Greene Mosheim Public Library 7 $16,076.00 96 188
Grundy Altamont Public Library 7 $16,076.00 62 115
Grundy May Justus Memorial Library 7 $16,076.00 67 74
Hancock Hancock County Public Library 12 $21,866.00 93 127
Hardeman Bolivar-Hardeman County Library 7 $16,076.00 312 341
Hardin Hardin County Library 12 $21,866.00 120 404
Hawkins Church Hill Branch Library 12 $21,866.00 81 167
Hawkins H. B. Stamps Memorial Library 12 $21,866.00 95 203
Hawkins Mt. Carmel Library 7 $16,076.00 63 41
Haywood Elma Ross Public Library 12 $21,866.00 109 373
Lexington-Henderson County Everett
Henderson Horn Public Library 12 $21,866.00 61 136
Henry W. G. Rhea Public Library 12 $21,866.00 76 227
Hickman East Hickman Branch Library 12 $21,866.00 90 103
Hickman Hickman County Public Library 12 $21,866.00 66 93
Houston Houston County Public Library 12 $21,866.00 219 172
Charles Ralph Holland Memorial
Jackson Library $16,076.00 60 123
Jefferson Jefferson City Public Library $16,076.00 197 347
Johnson Johnson County Public Library 12 $21,866.00 60 51
Lake Tiptonville Public Library 7 $16,076.00 103 138




Laptop Lap Grant Program

2012-1014

Lauderdale Lauderdale County Library $16,076.00 60 36
Lawrence Lawrence County Public Library $16,076.00 78 123
Lewis Lewis County Public Library 7 $16,076.00 69 113

Fayetteville-Lincoln County Public
Lincoln Library 12 $21,866.00 61 134
Macon Macon County Public Library 12 $21,866.00 60 30
Macon Red Boiling Springs Branch Library 7 $16,076.00 60 41
Marion Jasper Public Library 12 $21,866.00 90 387
McMinn E. G. Fisher Public Library 12 $21,866.00 244 225
McNairy Irving Meek, Jr. Public Library $16,076.00 180 206
McNairy Jack McConnico Memorial Library $16,076.00 60 89
Meigs Meigs-Decatur Public Library 12 $21,866.00 143 42
Monroe Sweetwater Public Library 12 $21,866.00 138 211
Morgan Coalfield Public Library $16,076.00 110 174
Morgan Sunbright Public Library 7 $16,076.00 60 78
Obion Obion County Public Library 12 $21,866.00 173 297
Overton Millard Oakley Public Library 12 $21,866.00 114 343
Perry Lobelville Branch Library $16,076.00 91 72
Perry Perry County Public Library $16,076.00 64 114
Pickett Pickett County Public Library 12 $21,866.00 61 194
Polk East Polk Public Library 7 $16,076.00 70 105
Putnam Monterey Branch Library 7 $16,076.00 60 130
Rhea Clyde W. Roddy Public Library 12 $21,866.00 62 55
Roane Kingston Public Library 12 $21,866.00 122 88
Roane Rockwood Public Library 12 $21,866.00 96 184
Scott Huntsville Public Library $16,076.00 152 119
Sequatchie Sequatchie County Public Library $16,076.00 60 116
Smith Smith County Public Library 12 $21,866.00 60 311
Stewart Stewart County Public Library 12 $21,866.00 140 201
Sullivan Sullivan County Public Library 12 $21,866.00 213 109
Trousdale Fred A. Vaught Memorial Library $16,076.00 60 151
Unicoi Unicoi County Public Library $16,076.00 60 40
Union Luttrell Public Library $16,076.00 60 151

Wm. H. & Edgar Magness
Warren Community House and Library 12 $21,865.00 75 209
Wayne Clifton Branch Library $16,076.00 60 52
Weakley C. E. Weldon Public Library $16,076.00 60 244
Weakley Dr. Nathan Porter Public Library $16,076.00 60 105

Ned R. McWherter Weakley County
Weakley Library 7 $16,076.00 60 180
White White County Public Library 12 $21,866.00 61 210
TOTALS 709 $1,456,577.00 7,818 13,262
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Tennessee Electronic Library CA_%(’TG L

www.tntel.info

FREE for every
Tennessean

Foreign Language Courses

Practice Tests & courses
Family history tools

Resume builder

Tennessee Electronic Library

TEL is your library
Magazines
Newspapers
Practice Tests
Language Learning
Genealogy
World Book

Tennessee Electronic Library

Homework Help
From science and math to history
and current events, TEL is an excel-
lent resource for students. Whether
preparing for a debate or practicing
for a college entrance exam, TEL
has something for every student.

Career Tools

Career Transitions helps those
searching for a new career, from dis-
covering interests and education pro-
grams to crafting a resume and cov-
er letter. Be at your best by practic-
ing for the interview ahead of time!
TEL is always available, no matter
when you need it, anywhere you
have an internet connection.

For Business Professionals
Tennessee Electronic Library pro-
vides business professionals with
access to an amazing collection of
resources that will help keep them
current in today’s changing market.
Visit the Small Business Resource
Center to find tools for becoming
your own boss. Or check out the fi-
nancial markets with Business
Insights Essentials. There are also
a variety of magazines and business
journals like Business Quarterly, The
Economist and Economics Week.

Genealogy Research
HeritageQuest provides Federal
Census records, local history books,
family histories and more.

For Educators
Not only can TEL help to enhance
the classroom experience by provid-
ing students access to complex
informational readings and sKill
building courses in math and read-
ing, but educators can take ad-
vantage of the wide range of materi-
als available for their own profes-
sional development. The Test Prep
in TEL includes practice exams for
the GRE and the Praxis | and Il

Check out
the kids page
www.tel4u.org

The Tennessee Electronic Library is made possible through funding provided by the General Assembly of the
State of Tennessee, the U. S. Institute of Museum and Library Services, and through pledges from Tennessee
libraries. TEL is administered by the Tennessee State Library and Archives, a division of the Tennessee Office
of the Secretary of State, Tre Hargett, Secretary of State.

Tennessee Electronic Library
www.tntel.info

615-532-4627

tel.tsla@tn.gov

INSTITUTE of

Museum...Library
SERVICES
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Computer Skills

= L= A

Anytime, anywhere

TECHNOLOGY AT YOUR FINGERTIPS

Life happens on the computer. We use it at work
and home for finding information, job searching,
social networking, and staying in touch with
family and friends. Learn the fundamentals
of your computer, the Internet, and popular
software applications with these easy-to-follow
multimedia tutorials—and take advantage of all
that today’s technology has to offer.

ONLINE LEARNING THAT WORKS!

P More than 100 self-paced online tutorials

P Beginner to advanced levels

P Fun to learn and easy-to-use

» Learn Windows & Mac OS X operating systems
> Gain proficiency in popular software programs
P Progress rapidly using self-directed videos |

P Anytime, anywhere online access |

PC & Internet Basics, Microsoft Office, and More

FOR FREE ACCESS, GO TO

www.tntel.info & click test prep

Litarnf nzmens
LearningExpress | An EBSCO Company  800-295-9556 - 80 Broad St., 4 Floor » New York, NY « 10004 www.learningexpresshub.com/corporate



LEARNINGEXPRESS | An EBsCO company

Computer Skills
Featured Resources

LearningExpress provides interactive online resources to help people achieve academic
and career success. The Computer Skills video courses are a fun and easy way to learn how
to use the computer, the Internet, and the software applications most commonly needed
for home, school, and work. The Computer Skills video courses are available as an add-on to
LearningExpress platforms.

S

=) Get Started with Your Computer

Getting to Know Your Computer
» Computer Basics 1: Roles of Computers
» Computer Basics 2: Personal Computer
Using Your Desktop Applications
» Computer Basics 3: The Basics of
Windows 7
» Computer Basics 4: Customizing
Windows 7
» Computer Basics 5: Application Basics
» Computer Basics 6: Organizing Data
» Computer Basics 7: Web Browsing
» Computer Basics 8: Printing

Computer Safety and Maintenance
» Computer Basics 9: Maintenance and
Security

@) Get Started with the Internet

Discover the Internet
» Internet Basics 1: What is the Internet?
» Internet Basics 2: Surfing the Internet
» Internet Basics 3: The Internet as a
Search Tool
» Internet Basics 4: Using One-on-One
Communications
Using Your Emall
» Internet Basics 5: Email Etiquette
Social Media Tools
» Internet Basics 6: Branching Out Using
the Internet
» Internet Basics 7: Understanding Social
Networking
» Internet Basics 8: Using Web Tools
Internet Safety
» Internet Basics 9: Protecting
Yourself Online

" H’ Popular Software Tools

Microsoft Access

» Access 2013 - Basic
» Access 2013 - Int.

» Access 2013 - Adv.
» Access 2010 - Basic
» Access 2010 - Int.

» Access 2010 - Adv.
» Access 2007 - Basic
» Access 2007 - Int.

» Access 2007 - Adv.

LearningExpress | An EBSCO Company

Interactive, easy-to-use, unlimited remote access

Microsoft Excel
» Excel 2013 - Basic
» Excel 2013 - Int.
» Excel 2013 - Adv.
» Excel 2013 - What's New
» Excel 2010 - Basic
» Excel 2010 - Int.
» Excel 2010 - Adv.
» Excel 2010 - Expert
» Excel 2008 - Basic (Mac)
» Excel 2008 - Adv. {Mac)
» Excel 2007 - Basic
» Excel 2007 - Int.
» Excel 2007 - Adv.
Microsoft Outlook
» Outlook 2013 - Basic
» Outlook 2013 - Int.
» Outlook 2013 - Adv.
» Outlook 2013 - What's New
» Outlook 2010 - Basic
» Outlook 2010 - Int.
» Outlook 2010 - Adv.
» Outlook 2007 - Basic
» Outlook 2007 - Int.
» Outlook 2007 - Adv.
Microsoft PowerPoint
» PowerPoint 2013 - Basic
» PowerPoint 2013 - Int.
» PowerPoint 2013 - Adv.
» PowerPoint 2013 - What's New
» PowerPoint 2010 - Basic
» PowerPoint 2010 - Adv.
» PowerPoint 2008 - Basic (Mac)
» PowerPoint 2008 - Adv. (Mac)
» PowerPoint 2007 - Basic
» PowerPoint 2007 - Adv.
Microsoft Project
» Project Pro 2013 - Basic
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